Description

2D Consolidation
under a Strip
Footing

For LUSAS version: 18.0

For software product(s): | Any Plus version.

With product option(s): Nonlinear, Dynamic.

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description
The pore water pressure 5]
dissipation and settlement
in a soil following the

application of a T S
distributed load is to be .
investigated. L

Horizontal displacement

. L 100m N
at the left edge is ! !
restrained to model the @ Young’s modulus of the soil  E=34.7 x 10> kN/m?
symmetrical ~ boundary o Poisson’s ratio vL=035
condition. Vertical § Density p=19tm*
d:csphlacemept at th_e base Bulk modulus of water K= 2.2 x 10°kN/m?
of the s,_0|l is restrained as Void ratio s 1174
the soil rests on solid

Unit weight of water 7= 9.812 kN/m®

rock. The pore pressure
at ground level is Soil permeability ke=ky=kz=1.0 x 10°® m/s

prescribed to zero.

Units of kN, m, t, s, C are used throughout.




&

Modelling

2D Consolidation under a Strip Footing

Objectives

The required output from the analysis consists of:

U Settlement at the centre of the footing with time.

O Pore pressure distribution immediately after application of the load (undrained
response)

U Pore water pressure dissipation with time at the centre of the footing

Keywords

2D, Plane Strain, Consolidation, Pore Water Pressure, Time Stepping, Nonlinear,
Transient, Settlement, Two Phase Materials, Default Assignments, Graphs

Associated Files

U pwp_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS Modeller
in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter a File name of pwp

o Use the default User-defined working folder.
e Ensure an Analysis type of Structural is set.
e Select an Analysis Category of 2D Inplane

e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of 2D Plane Stress.

e Ensure the Layout grid is set as None




| Attributes

[Mesh
|Surface...

Modelling

e Enter a Title of Consolidation under a Strip Footing

e Click the OK button.

Note. The Undo button may be used to correct a mistake. The undo button allows any
number of actions since the last save to be undone.

Mesh Definition

Since this analysis requires the modelling of pore water pressure, plane-strain two phase
elements will be used.

e Select Plane strain two phase, Quadrilateral, Quadratic elements. Ensure the
Regular mesh option is selected with Automatic chosen so that Modeller will use
the mesh divisions assigned to each line.

e Give the attribute the name Plane Strain Two Phase and click the OK button to
add the mesh attribute to the e?b Treeview.

e Inthe b Treeview click on the mesh attribute Plane Strain Two Phase with the
right-hand mouse button and select the Set Default option. This will ensure all
newly created surfaces will be assigned the elements defined in this mesh attribute.

Material Properties

For consolidation analysis both the elastic and two-phase soil properties need to be
defined. The overall ‘equivalent’ bulk modulus of the soil is related to the bulk modulus
of the pore fluid and the bulk modulus of the solid soil particles by the formula:

1_n @@-nm n
Ke Kf Ks Kf

Where
Ke is the equivalent bulk modulus of the soil
Kf is the bulk modulus of the pore fluid
Ks is the bulk modulus of the solid soil particles
n is the porosity of the soil

The porosity of the soil is related to the void ratio by the formula:

e
Porosity N =——=0.54
1+e
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| Attributes e Enter the isotropic material properties for the soil as Young’s Modulus 34.7E3,
| Material _ > Poisson’s Ratio 0.35 and Mass density 1.9
| Isotropic...
o Click on the Two phase check box at the top right-hand corner of the dialog.
Isotropic
[~ Plastic I creep [~ Damage [~ Shrinkage ™ Viscous ¥ Two phase ™ Ko Initialisation
"Hlastic Two Phase |
& Fully saturated Value
~ . Bulk modulus of solid phase 2.2e6
Partially saturated Bulk modulus of fiuid phase 3508
" Piecewise linear partially saturated Parosity of medium 054
Hydraulic conductivity in global X direction 0.01e-6
Define cUrEs. . | Hydraulic conductivity in global Y direction 0.01e-6
Hydraulic conductivity in global Z direction 0.01e6
™ Incompressible sclids Density of fluid 04
Mame | Fissured Clay j i’ (new)
oK I Cancel | Apply | Help |

e Fora Fully saturated condition enter the properties as shown in the dialog above.

Note. For the purposes of this example and to comply with a corresponding test case
/ the undrained bulk modulus of the soil is set to be the same as that of the pore fluid.

e Enter the attribute name as Fissured Clay and click the OK button to add the
attribute to the &% Treeview.

o Inthe &b Treeview click on the attribute Fissured Clay with the right-hand mouse
button and select the Set Default option. This will ensure all newly created features
will be assigned the properties defined in this material attribute.




| Geometry
[Surface >
By Coords...
| Geometry
[Surface >
By Coords...
| Attributes
[Mesh >
Line...

Modelling

Feature Geometry

_I Enter coordinates of (0, 0), (5, 0), (5, 10) and (0, 10) to define the soil under the
load. Use the Tab key to move to the next entry field on the dialog. When all
coordinates have been entered click the OK button.

J Enter the coordinates of (5, 0), (100, 0), (100, 10), (5, 10) to define the remainder
of the soil.

Mesh Grading

Define a Line mesh with element type None and 16 divisions.
Select the Spacing button.

Choose the Uniform transition option and set the Ratio of first to last element to
0.1

Click OK to accept the spacing properties.

Give the attribute name as Null 16 Graded and click the Apply button to add the
attribute to the & Treeview and keep the dialog active.

Define a Line mesh with 12 divisions.

Select the Spacing button.

Enter the Uniform transition option and set the Ratio of first to last element to 5
Click OK to accept the spacing properties.

Give the attribute name as Null 12 Graded and click OK to add the attribute to the
& Treeview.




| Attributes

Loading...

2D Consolidation under a Strip Footing

Select these 2 horizontal Lines
and assign "Null 16 Graded"

N

- )

VY VA

Select these 3 vertical Linesand assign "Null 12 Graded"

Select the horizontal lines of the larger surface as shown and assign the mesh
attribute Null 16 Graded

Select all the vertical lines as shown (Use the Shift key to add to the initial
selection) and assign the mesh attribute Null 12 Graded

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line, and using the Geometry>Line>Reverse menu.
The end result should be a mesh that looks like this:

Supports

Assign the supports to the model.

Select the vertical Line on the left-hand side of the model and drag and drop the
support attribute Fixed in X from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

Select the 2 horizontal Lines representing the base of the soil and drag and drop the
support attribute Fixed in Y from the & Treeview onto the selection. With the
Assign to lines option selected click OK to assign the support attribute to All
analysis loadcases

Loading
To define the distributed load:

Select the Face option and click Next

Enter loading of 3450 in the y Direction
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Modelling

e Enter the attribute name of Distributed Load and click the Finish button.

e Select the top line on the left-hand side of the model and drag and drop the
Distributed Load attribute onto the selection. With the Assign to lines option
selected click OK to assign the loadcase attribute to All loadcases.

Select thisline

Analysis Control

Undrained loading stage
The undrained loading of the soil must be calculated to establish the initial conditions
of the consolidation analysis.

o In the ‘! Treeview expand Analysis 1 then right-click on Loadcase 1 and select
Nonlinear & Transient from the Controls menu.

Nonlinear & Transient

 Incrementation Solution strategy
¥ Monlinear ™| 5ame a5 previous lnadcass
Incrementation IManuaI 'l Max number of iterations I 12
Starting load factor 0.1 Residual force norm I 0.1
Max change in load factor I 0.0 Incremental displacement norm I 1.0
Max total load factor 1.0 Advanced... |
¥ | adjust lnad based on convergence
rIncremental LUSAS file output
Iterations per increment I 4 ™| 5ame as previous loadease
I~ | bisplacement reseb Output file I 1
fid il
[ F—
v Time d i
@ —— Restart file I 0
Consolidation =
Initial time step ll— Max number of saved restarts I 0
Total response time I 1 Log file I 1
™| Butomatic kime sEepREing History file I 1
&I [™ save arestart at the end of this control
—Common to all
Max time steps or increments I a
OK I Cancel Help
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In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 1

o Enter Total Response Time of 1.

e Set Max time steps or increments to 0.

Consolidation stage

To allow dissipation of the excess pore-water pressures a drainage path must be defined
which for this example is through the ground level of the soil. A new loadcase needs to
be created for this.

| Analyses e Click OK to create Loadcase 2
Loadcase...
Supports
Define a support to prescribe zero pore pressure.
| Attributes e Specify the Pore pressure to be Fixed.
Support...

e Enter the attribute name as Drainage Path and click the OK button.

e Select the Line at ground level on the right-hand side of the model (see image) and
drag and drop the support attribute Drainage Path from the &b Treeview onto the
selection. With the Assign to lines option selected, choose the From loadcase
(nonlinear and transient) option to assign the supports to Analysis 1 and
Loadcase 2.Click OK.

Select thisline

Loading

| Attributes e Select the Prescribed displacement option and click Next

Loading...




Modelling

e With the Total option selected, set the Pore Pressure to be Fixed and enter a
prescribed displacement of 0. Name the attribute Surface Excess Pore Water
Pressure and click OK.

e Select the Line at ground level on the right-hand side of the model (see image
above) and drag and drop the loading attribute Surface Excess Pore Water

Pressure from the &b Treeview onto the selection for a Single loadcase named
Loadcase 2.

Analysis Control

Consolidation stage

With this consolidation problem an automatic time stepping procedure is adopted. This
is because consolidation is a typical diffusion process in which the field changes rapidly
at the start of the process before settling down to a steady state condition a considerable
time after the initial load is applied. The automatic time stepping procedure enables the
time step to be modified so that the small time steps required at the start of the problem
can be increased as the analysis progresses. In some cases the overall response time can
be orders of magnitude larger than the initial time step.

The initial time step is important since the early variations in pore pressure must be
accurately accounted for. Vermeer and Verruijt suggest the following criteria for
determining the initial time step where Ah is the minimum distance between nodes.

9.812
6 x34.7E3x1E-8

x 0.14% ~100 secs

At > Lo (any =
6Ek
Note. The distance between two nodes can be determined by selecting the two nodes
and then picking the Tools> Mesh> Distance between Nodes menu item.

o In the ‘! Treeview expand Analysis 1 then right-click on Loadcase 2 and select
Nonlinear & Transient from the Controls menu.
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Nonlinear & Transient

~ Incrementation —Solution strategy
v Monlinear I~ | same as previous loadcase
Incrementation Im Max number of iterations
Starting load factor 0.1 Residual force norm
Max change in load factor I 0.0 Incremental displacement norm | 1.0
Max total load factor 1.0 Advanced...

¥ | Adjust lnad based jon convergence
rIncremental LUSAS file output

Iterations per increment I 4 ™| Same as previous [nadease

™| bisplacement reset Output file

Advanced. .. | Plot fle
IConsoIidation = I ReEwis

Initial time step 100 Max number of saved restarts |0

Total response time I 100.0E6 Leg file

Histaory file

Advanced... | [™ Save a restart at the end of this control
r~Common to all

Max time steps or increments I 50
oK I Cancel Help

¥ Time domain

T

= | Autamatic bime stepping

In the Incrementation section:

e Select the Nonlinear option and choose Manual incrementation.

e Select the Time domain option and chose Consolidation from the drop down list.
e Enter an Initial time step of 100

e Enter Total Response Time of 100ES.

e Set Max time steps or increments to 50.

e Select the Advanced button in the Time domain section of the dialog.
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| File

Save

Running the Analysis

e On the Advanced time Step Advanced Time Step Parameters
parameters dialog set the ‘Time step
increment restriction factor’ to 2 B o
Time step increment restriction factor I 2

e Set the ‘Minimum time step’ to 100 e w3

e Ensure the ‘Maximum time step’ is eI IEeEy

set to 100E6 Minimum time step for termination I 0.0

™| Expoment for increasing bime step 3.0

e Ensure the ‘Minimum time step for
termination’ is set to 0 LT R I [o0

Integration factor beta 1.0

e Click OK to return to the Nonlinear

. R Integration factor gamma 0.5
and Transient control dialog.

| allow step reduckions

¢ Click OK to set the loadcase control. e Bl

Saving the model

El Save the model file.

Running the Analysis

A

El Open the Solve Now dialog. Ensure Analysis 1 is selected and press OK to run
the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...

Analysis loadcase results are added to the (2 Treeview.

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U pwp.out this output file contains details of model data, assigned attributes
and selected statistics of the analysis.

U pwp.mys this is the LUSAS results file which is loaded automatically into
the Treeview to allow results processing to take place.
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| File

2D Consolidation under a Strip Footing

[New...

| File

| Script

| Run Script...

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O pwp_modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open, Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as pwp

e To recreate the model, select the file pwp_modelling.vbs located in the \<LUSAS
Installation Folder>\Examples\Modeller directory.

El Rerun the analysis to generate the results.

Viewing the Results

Loadcase results can be seen in the .= Treeview. For a nonlinear analysis the last solver
results time step is set active by default.

o If present, turn off the Geometry, Mesh and Attributes layers in the 5= Treeview.

Settlement

e In the (5 Treeview, right-click on the first load increment Time Step 0 and select
the Set Active option to view results immediately after the loading is applied.

e Click the Deformations button in the Treeview and select the Specify factor
option. Specify a factor of 1 and click OK to visualise the deformed mesh for the
first time step.

12



| utilities

Graph Wizard...

Viewing the Results

A graph of the deformation over time will be created using the graph wizard.

e Zoom into the left-hand side of the Select this node
model and select the node on the
centre line at the centre of the

fOOting. f

Graphing settlement T

e With the Time history option
selected click Next _—

Firstly define the data to be used for
the X axis.

o Selected the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis.

¢ With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.

e The selected node number will appear in the Specified single node drop down list.
Click Next

For the X Scale enter Manual values of minimum 100 and maximum 10e6
respectively.

e Select the Use logarithmic scale option.
o Title the graph as Settlement under centre of footing

e Click Finish to display the graph of settlement over time under the centre of the
strip footing.

13
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E Close the graph window

Pore water pressure

The distribution of pore pressure is to be shown using contours.

With Time Step 0 set active in the @ Treeview, and with no features selected, click
the right-hand mouse button in a blank part of the view window and select

Contours to add the contours layer to the 5 Treeview.

Select Displacement from the Entity drop down list and PRES from the component
drop down list.

Select the Contour Range tab and set the Interval to 250

Click the OK button to display contours of the undrained pore pressure distribution
(Time step 0) immediately after the loading is applied.
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| utilities

Graph Wizard...

Viewing the Results

Analysis Analysis 1

Loadcase; 1:Loadcase 1, 1:Time Step 0 Time = 0.000000E+00
Results fle: pwp~Analysis 1.mys

Entity: Displacement

Component PRES (Units: kN/m2)

Maximum 3.14978E3 at node 751
Minimum -879.176 at node 755

Note. The dissipation of pore water pressure over time may be observed by creating
an animation of the contour display.

e To observe the distribution of pore water pressure at a particular time after the

application of loading, activate the appropriate time step from the () Treeview by
selecting the time step with the right-hand mouse button and choosing the Set
Active option.

Graphing pore water pressure
The dissipation of pore water pressure under the footing is to be presented on a graph.

e Select the node on the centreline under the footing as before.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis:

e Selected the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis:

e With the Nodal option selected and click Next

e Select Displacement from the Entity drop down list and PRES from the Component
drop down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next
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| Utilities

Graph Wizard...

2D Consolidation under a Strip Footing

e For the X Scale ensure that Manual values of minimum 100 and maximum 10e6
respectively are used.

e Ensure the Use Logarithmic scale option is selected.
e Forthe Y Scale leave the values as the defaults.
o Title the graph as Dissipation of pore water pressure

e Click Finish to display the dissipation of pore water pressure over time under the
centre of the strip footing.

Dissipation of pore water pressure
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—®— Node 745(4) / Response time(3)

E Close the graph window.

Graphing effective stress in soil

As the pore water dissipates the load is carried by the soil. The increase in effective
stress in soil can be observed on a graph of effective stress against response time.

e Ensure the node on the centreline under the footing still selected.
e With the Time history option selected click Next

Firstly define the data to be used for the X axis

e Select the Named option and click Next

e Select Response Time from the drop down list and click Next
Secondly define the data for the Y axis

e With the Nodal option selected and click Next

16



Viewing the Results

e Select Stress from the Entity drop down list and SY from the Component drop
down list.

e The extent to be graphed will be set to Specified single node and the node selected
will be seen in the Specify node field. Click Next

e For the X Scale ensure that Manual values of minimum 100 and maximum 10e6
respectively are used.

o Ensure the Use Logarithmic scale option is selected.
e Forthe Y Scale leave the values as the defaults.
o Title the graph as Effective soil stress

o Click Finish to display the graph of the effective soil stress over time under the
centre of the strip footing.

Effective soil stress
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This completes the example.
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